ELEMENTARY MATHEMATICS FOR BIOLOGISTS — 2010

Task 3 — More about Charting in Excel 2003
The third task gives further details about charting (in Excel 2003). In particular some of the
many ways in which the appearance of a chart can be improved are explained. On the downside, some limitations are noted too. Note that Excel 2003 is not the most recent version of
Excel 2003, and Excel 2007, the next version of Excel, has a significantly different user
interface.

Outline Requirements
1. Log in to a PWF workstation.
2. Set up, in the Maths folder, an Excel file Powers.xls which contains a single worksheet
with an embedded chart whose appearance is roughly as shown overleaf.
3. Use Edit | Fill ▸ Series... to set up the first two columns. [Page 3.3 et seq.]
4. Use Insert | Name ▸ Create... to associate the name a with the value 1. [Page 3.14]
5. Print the result and show the hard-copy to a demonstrator.
6. Work through problem 4: the Bacterial Growth problem.
7. Note the results of the experiments suggested at the end of problem 4.

Check-List
The demonstrator will have the following questions in mind when inspecting your work:
1. Are the four columns of information centred over the embedded chart?
2. Is the entire worksheet centred horizontally?
3. Are the headings right aligned?
4. Are the superscripts in the headings and in the chart as overleaf? [Pages 3.4 and 3.12]
5. Are there always two places shown after decimal points? [Page 3.12]
6. What formula gives rise to the value 1.00? [Page 3.14]
7. Have the tick marks been removed from both axes? [Page 3.8]
8. Does the chart contain two data series, one shown as a solid line and the other shown as a
broken line? [Page 3.12 et seq.]
9. Do the two lines in the legend approximately align with the end points of the two data
series? [Page 3.13]
10. Are the labels in the legend as overleaf (and so not very satisfactory!)? [Page 3.15]
11. What happens to the broken line when the value associated with a is changed from 1 to 4,
then 10, then 32, then 100, then 0.1 in turn? [Page 3.15]
12. Is there a footer showing your name and college?
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A. B. Smith of Churchill College

Task 3 — More about Charting in Excel 2003
Synopsis: Series. Formatting and Editing Charts. Naming Cells. Chart Sheets.

Briefing
The version of Excel referred to in this document is Microsoft Excel 2003. Note that Excel
2003 is not the most recent version of Excel 2003, and Excel 2007, the next version of
Excel, has a significantly different user interface. Task 2 touched on the charting facilities
available in Excel 2003. Some more advanced facilities are introduced in this session.

Guided Practical Session
• Log in to a PWF.
• Close the Message-of-the-day window.
• Start Excel:
start | Programs | Spreadsheets Maths and Statistics | MS Excel
A Linear Series
The first illustration in this session shows a quick way of putting the values 1 to 10 into cells
A1 to A10. Such a sequence is referred to by Excel as a Series. Since the values increase at a
uniform rate, this is a linear series.
• Check that A1 is the active cell. Key in 1 and click the Enter box to confirm.
• Open Edit and choose Fill ▸ Series...
The Series dialogue box offers several options but it is simple to see what is required. The
series is to be arranged in a column, it is linear and it increases by one at each step until it
reaches a final value of 10. Some options are correct by default:
• Click the Columns option button under the heading Series in.
• Check that Linear is selected under Type by default.
• Check that the Step value is 1 by default.
• Click in the Stop value box and key in 10.
• Click OK. The values 1 to 10 should appear in the first column.
If the values appear in the first row you forgot to click the Columns option button.
A Growth Series
Go back a step before embarking on the second illustration:
• Open Edit and choose Undo Series. All but cell A1 should be cleared.
• Check that A1 is the active cell and has the value 1.
• Drag from cell A1 to cell A11 to select the first eleven cells in column A.
• Open Edit and choose Fill ▸ Series...
• Check that the Columns option is still selected and for this second illustration…

– 3.3 –

• Click the Growth option button under Type.
• Change the Step value to 2. Leave the Stop value blank.
With a linear series, a step value of 2 would mean that the values increased by 2 at each step
as in 1,3,5,7,… With Growth selected the values are multiplied by 2 at each step as in
1,2,4,8,…
There are two ways of determining how far a series will run. You can either specify an
explicit Stop value or you can select a range of cells to be filled before you embark on the
Fill ▸ Series... command.
Given, this time, that the range A1:A11 has been selected, the doubling will continue until a
value has been calculated for cell A11:
• Click OK and the series appears in the first 11 cells in column A. These values are powers
of 2 running from 1 (20) to 1024 (210) so 2n will be used as a heading…
• Click row label 1 to select the whole of row 1.
• With the pointer somewhere in this row, click the right-hand mouse button.
• From the pop-up menu choose Insert. A blank row appears at the top.
• Make A1 the active cell and key 2n (we’ll convert this to 2n in a moment) into this cell.
Click the Enter box to confirm and then click the Align Right button ( ) to align 2n
with the values below it.
To turn 2n into 2n takes two steps: n is made italic and then made a superscript…
• Check that A1 is still the active cell and in the Formula Bar drag across the letter n only.
This selects the letter n as can be seen by the highlighting (which extends to the righthand end of the Formula Bar).
• With the n selected, open Format and choose Cells... Note the Font style heading in the
Format Cells dialogue box.
• Click Italic in the list box under Font style.
• Click the Superscript checkbox under Effects.
• Click OK and then click the Enter box to complete the process. You should see something
like 2n in cell A1 (but the version in the Formula Bar is unchanged).
• Click the Bold button (

) to make the heading bold.

A Graph
The powers of two can be plotted on a graph. The Chart Wizard will be used:
• Select the range A1:A12 (include the heading).
• Click the Chart Wizard button

in the Standard Toolbar.

• The Step 1 tab dialogue box is headed Chart Type and has two tabs. Ensure that the
Standard Types tab is selected; click it if it is not.
• The Standard Types tab offers numerous Chart types with several Chart sub-types for
each. Select Line (as the Chart type) and the fourth Chart sub-type should be selected
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by default. This latter is described as Line with markers displayed at each data
value.
• Click Next> to go on to Step 2.
• The Step 2 tab dialogue box is headed Chart Source Data and has two tabs. Ensure that
the Data Range tab is selected; click it if it is not.
The preview chart in Step 2 shows a draft version of the chart. Below the preview chart there
is a note that the range that you selected is Sheet1!$A$1:$A$12$ (the dollar-signs have no
significance here). There is also confirmation that the Series is in a Column.
The preview chart reveals a couple of problems:
1. The vertical scale has to accommodate values up to 1024 even though the majority of the
values plotted are less than a tenth of this maximum. The left-hand half of the plot is not
very useful. A logarithmic plot would be better and this alternative will be explored
shortly.
2. The numbers against the horizontal axis are not very sensible. You should be able to read 1
to 11 (though 10 may be missing its second digit). Since the series runs from 20 to 210 it
would be better if the labels ran from 0 to 10.
The sensible way to proceed now is to go back one step and see whether there is a more
suitable Chart type:
• Click <Back to go back to Step 1.
• Scroll down the list of Chart types. Unfortunately there is no sign of a logarithmic type.
• Select the Custom Types tab. There may be a short wait while these more specialised
types are loaded. Scroll down the list of Chart types now and notice that Logarithmic
is in the list.
• Select Logarithmic. A preview chart under the heading Sample shows a straight line plot
which is what you should expect.
• Click Next> to go on to Step 2. The preview chart now looks better but there is still the
problem with the numbers against the horizontal axis.
• Select the Series tab.
The Series tab gives a clue. The Name text box shows that the name of the chart has been
taken from cell Sheet1!$A$1 and the Values text box shows that the values have been taken
from the range Sheet1!$A$2:$A$12$. A third text box shows where the Category (X) axis
labels have come from and this box is blank. This matter will be attended to later.
• Click Next> to go on to Step 3.
• The Step 3 tab dialogue box is headed Chart Options and has six tabs. Ensure that the
Titles tab is selected; click it if it is not.
• In the Chart title text box replace 2n by POWERS OF TWO.
• Click in the Category (X) axis text box and key n into that box.
• Click in the Value (Y) axis text box and key 2n (which will eventually be converted to 2n)
into that box. This probably appears sideways on the preview chart.
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Next look at the other Chart Options tabs:
• Select the Axes tab. There are two checkboxes, one for the Category (X) axis and one for
the Value (Y) axis and both checkboxes show a tick (!).
• Click these two checkboxes in turn and notice that the numbers against the two axes on the
preview chart are removed.
• Click these two checkboxes again and notice that the numbers against the two axes reappear
which is what you want.
• Select the Gridlines tab. The gridlines on a chart take the form of horizontal or vertical
lines which run the full width or height of the chart. The Gridlines tab probably
indicates that there are no Category (X) axis gridlines but, on the Value (Y) axis, there
are Major gridlines. Leave these checkboxes alone at this stage.
• Select the Legend tab. You can probably see the legend against the right-hand side of the
preview chart. It includes a tiny 2n (and not 2n which would be better).
• Click the Show legend checkbox to deselect the legend.
• Select the Data Labels tab. There are probably no ticks in any of the checkboxes.
• Click the Value checkbox. Notice that each marked point on the plot shows the value
associated with that point. Deselect the Value option.
• Click the Category name checkbox. Notice that each marked point on the plot shows the
(ill-chosen) value on the x-axis. Deselect the Category name option. There seems no
good reason this time for selecting any of the options.
• Select the Data Table tab and click the Show data table checkbox. A table appears below
the x-axis showing the data in tabulated form.
• Click the Show data table checkbox again to deselect this feature.
Now move on to the last step:
• Click Next> to go on to Step 4.
• The Step 4 dialogue box is headed Chart Location and has no tabs. Ensure that the chart
will be placed As object in: Sheet1 and click Finish. The completed chart appears.
• Use the drag handles on the chart border to make the chart exactly fill the region D1:K15.
This chart will be improved in several ways but first save the worksheet…
Saving the Worksheet
Remember that you can use the Save button with a new workbook because Excel will
automatically behave as though the Save As... command had been given:
• Click the Save button on the Standard Toolbar. The list box in the Save As dialogue box
shows your top-level folders including Notes.
• Double-click the Notes folder and check that the list box shows the folders contained in
Notes including Maths.
• Double-click the Maths folder. It is likely that no files are shown in the list box because
you probably have no Excel files in the Math folder yet.
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• Click in the File name text box and overwrite whatever is in it with Powers and click
Save. This saves the file, and Book1 in the Title bar changes to Powers.xls.
Chart Items — Terminology
The different parts of a chart are referred to as chart items and it is useful to rehearse some of
the terminology before looking at a few of the many facilities for formatting and editing
charts.
The three most important chart items are the two axes and the line of the plot. The horizontal
axis is variously referred to as the Category (X) axis or the x-axis and the vertical axis is
variously referred to as the Value (Y) axis or the y-axis. The line is formally called a data
series and note that this has a marker (a diamond-shaped blob) at each point.
The two axes form the left-hand and lower boundaries of the Plot Area, the central region of
the chart. The Plot Area lies within the Chart Area which is delimited by the outermost
boundary of the chart.
Each axis has an Axis Title (n and 2n at the moment) and the Chart Title is at the top. Both
axes also carry labels (the values 1 to 11 and 1 to 10000).
The x-axis has obvious tick marks, little lines which dangle down from the axis near the
labels. The y-axis also has tick marks which stick out to the left of the axis but, as noted
earlier, it also has gridlines which run across the full width of the Plot Area. The major
gridlines are associated with the labels 10, 100 and so on. It is possible to have minor
gridlines too which indicate sub-divisions.
A chart can also have a legend but this item was deselected earlier.
• Move the pointer to the various items in the chart and notice that, after a one-second wait,
an advisory notice appears close to the pointer. The notice usually indicates what the
item is. When you point at a marker on the data series the notice even gives the value at
that point.
• Next, (single-)click on the various items in the chart. In most cases this action selects the
item and it is highlighted in some obvious way. Try selecting the main title, the x-axis
and the data series in turn.
• Click in the Chart Area, anywhere just inside the surrounding border. When the Chart Area
is selected, the selection is indicated by the appearance of the eight drag handles that
were present when the chart first appeared.
• Notice the Chart menu in the Menu bar. Click an arbitrary cell outside the chart. This
deselects the chart (all evidence of selection disappears) and the Chart menu is replaced
by the Data menu.
The Chart Menu
If you wish to revise a decision made when using the Chart Wizard the Chart menu is the
one to use. This exists only if the chart is selected:
• Click somewhere inside the chart. This selects some item of the chart and the Chart menu
takes over from the Data menu in the Menu bar.
• Open Chart and notice that the first four entries exactly correspond to the four steps in the
Chart Wizard:
1. Chart Type...
– 3.7 –

2. Source Data...
3. Chart Options...
4. Location...
Suppose you wish you had opted for vertical gridlines as well as horizontal gridlines:
• Open Chart and choose Chart Options... This opens the Chart Options tab dialogue box.
• Select the Gridlines tab and arrange for both Major gridlines checkboxes to have ticks in
them and both Minor gridlines checkboxes to be clear. The preview chart displays the
vertical gridlines.
• Click the lower Minor gridlines checkbox and notice how the new gridlines act as
subdivisions appropriate to a semi-log plot.
• Click the lower Minor gridlines checkbox again to clear the sub-divisions.
• Click OK. This closes the dialogue and the real chart appears with its new gridlines.
By using other tabs in the Chart Options dialogue box one can change other decisions made
earlier. For example one can bring back the legend or add data labels to the markers.
A more significant use of the Chart menu will be to attend to the problem of the labels on the
x-axis which currently run from 1 to 11 but should run from 0 to 10. This problem will be
kept pending for another couple of pages.
Formatting a Chart — The Format Menu and Double-Clicking
The Chart menu is for revisiting old ground. It is possible to make additional refinements to
a chart using the Format menu. In general terms, one selects some chart item which one
wants to adjust and then opens the Format menu. This menu will know which item has been
selected.
As an illustration, consider the vertical axis. It seems silly to have tick marks as well as
gridlines and it would be as well to remove them. It also seems silly to extend the axis as far
as 10000 when the maximum value (1024) is only a little above 1000. The Format menu
can be used as follows:
• First, select the Value (Y) axis by clicking one of its labels (for example, click 100). [One
could also select the axis by clicking a tick mark or the axis itself.] Notice that a blob
appears at each end of the axis to indicate selection.
• Open Format and notice that the first entry is Selected Axis... Choose that command to
open the Format Axis tab dialogue box which has five tabs.
• Ensure that the Patterns tab is selected; click it if it is not. One of several sets of options
boxes specifies that the Major tick marks are Outside the axis. Change from Outside
to None. This will clear the tick marks.
• Next, select the Scale tab. The information in this tab includes a ticked checkbox which
indicates that a Logarithmic scale is being used for this axis. Note also that the
Maximum is 10000.
• Click in the Maximum box and change the value to 1000. Click OK. This closes the tab
dialogue box and the real chart appears with the tick marks removed from the vertical
axis and the maximum value is now 1000.
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The next step is to remove the tick marks from the horizontal axis. One could go through the
same procedure of selecting the axis, opening Format and then choosing Selected Axis...
but there is a quicker way:
• First, select the Category (X) axis by clicking one of its labels. Again, a blob appears at
each end of the axis to indicate selection.
• Next, double-click the label. This action takes you straight to the Format Axis tab dialogue
box. It was unnecessary to do the single-click to select but that action is recommended
so you can verify that you are formatting the right item.
• Almost certainly the Scale tab is selected since this was the last tab used on the vertical
axis. The Scale tab has a rather different appearance now because the horizontal axis is
linear rather than logarithmic. Leave the entries in this tab alone.
• Select the Patterns tab. Clear the Major tick marks as before. Click OK.
The tick marks are removed from the horizontal axis of the real chart. The labels 1 to 11 still
need changing but the Format Axis dialogue box is not the place to make such a change.
Formatting a Chart — Changes to a Data Series
The next step is to format the data series to remove the markers:
• Click somewhere on the line of the plot between two markers. This selects the data series.
Notice that large blobs appear on all the markers to highlight the selection.
• Open Format and choose Selected Data Series... to open the Format Data Series tab
dialogue box which has six tabs.
• Immediately click Cancel to close the box. Open it again the quicker way…
• Click somewhere outside the chart and then double-click somewhere on the line of the plot.
This opens the Format Data Series tab dialogue box in a single step.
• Ensure that the Patterns tab is selected; click it if it is not. Under the Line heading, the
Automatic option has been selected by default. This gives a solid coloured line.
next to the Style box. This opens a drop-down list box which shows various
• Click the
styles of line. You could select long dashes or short dashes and so on. The default solid
line seems a good choice so click the
drop-down list box.
• Click the

next to the Style box again to get rid of the

next to the Color box. This opens a drop-down palette of colours.

• Click the black square in the palette. This will change the colour of the line.
Notice that by specifying a colour, the Automatic option is deselected and the Custom
option is selected instead.
Under the Marker heading, the Automatic option has likewise been selected by default. This
gives the diamond-shaped markers which are not needed, so…
• Click the None option then…
• Click OK. This closes the dialogue box. The markers appear still to be present but this is an
illusion. What you see is a highlighting effect to show that the data series is still
selected.
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Changing the Chart Type to XY (Scatter)
The labels on the x-axis currently run from 1 to 11 rather than from 0 to 10. No information
has been supplied in the worksheet to specify what the labels ought to be and Excel simply
noted that there were eleven values and naïvely used 1 to 11 for the labels.
The difficulty stems from choosing a Line chart in Step 1 of the Chart Wizard. The proper
choice would have been to use an XY (Scatter) chart, in which one set of values is plotted
against another and both sets of values are specified explicitly:
• Open Chart and choose Chart Type...
• Select XY (Scatter).
• Select the fourth Chart sub-type Scatter with data points connected by lines.
• Click OK.
Two consequences of this change are that the tick marks reappear and the markers reappear
on the data series. These features are still unwanted and a little revision is in order:
• Remove the tick marks from both axes. Note that a quick way of doing this is to remove the
tick marks from one axis, then select the other axis and press the F4-key (the repeat-lastaction key).
• Assuming the markers have reappeared on the data series remove them too.
The labels on the x-axis now run from 0 to 12. Excel still doesn’t know what the values
should be and the Source Data dialogue box will give a clue as to what is happening:
• Open Chart and choose Source Data...
• Click the Series tab in the Source Data dialogue box.
The text boxes record the way the Chart Wizard interpreted your original selection on the
worksheet.
The Name of the data series is taken from the first cell A1. The full address of this cell
includes the sheet name which is Sheet1. This name is separated from the cell identifier by
an exclamation mark. The full address of the first cell is therefore Sheet1!$A$1.
The values which constitute the data series, the Y Values, are in a range whose full address is
Sheet1!$A$2:$A$12.
On the other hand, the X Values box is waiting for an appropriate range and this means
making a temporary excursion:
• Click Cancel to close the dialogue box.
• Select cell A1. This is outside the chart so the Chart menu is replaced by the Data menu.
• Open Insert and choose Columns. A new blank column appears on the left. The data series
and the chart move to the right.
• Make A2 the active cell. Key 0 into cell A2.
• Click the Enter box to confirm.
• Open Edit and choose Fill ▸ Series...
• Select the Columns option. Leave the Type as Linear and leave the Step value as 1.
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• Set the Stop value to 10.
• Click OK.
This should put the values 0 to 10 in cells A2 to A12. Check this.
• Make A1 the active cell. Key in n and click the Enter box to confirm.
• Right-align this n and make it bold and italic.
This has incorporated into the worksheet the values which are suitable labels for the x-axis.
You can now pay attention to the chart again:
• Click anywhere in the chart. Note that the Chart menu takes over from the Data menu
once more.
• Open Chart and choose Source Data...
• Click in the X Values box and be prepared for an unusual window which appears when
you drag out a region of the worksheet…
• Check that the insertion point is in the X Values box then, in the worksheet, drag from cell
A2 to cell A12 to select the values 0 to 10 which are required as labels for the x-axis. A
curious window with a single text box indicates how the dragging process is proceeding.
When the mouse button is released the range Sheet1!$A$2:$A$12 should appear in the
X Values box.
• Click OK.
The data series now runs through the point (0,1) and the labels are appropriate: it is now
more obvious that 26 has the value 64. Next, shorten the axis:
• Double-click a label on the Category (X) axis to open the Format Axis tab dialogue box.
• Select the Scale tab.
• Change the Maximum to 10 and change the Major unit to 1.
• Click OK. At last the x-axis labels are as required.
Formatting a Chart — Changes to Titles
• Click, in turn, the n, the 2n and the POWERS OF TWO titles. Whenever titles are
selected in this way a border appears highlighting the item.
• With POWERS OF TWO selected, drag across the word TWO from left to right. This
highlights the word. Key in 2 so the chart title changes to POWERS OF 2.
• Double-click 2n to open the Format Axis Title tab dialogue box.
• Select the Font tab and change the Size to 11 points.
• Select the Alignment tab. Under the Orientation heading, the orientation is indicated in
Degrees. Set the orientation to 0 Degrees.
• Click OK. The 2n axis title should now be horizontal.
• With 2n still selected, drag across the n to highlight that letter.
• Open Format and choose Selected Axis Title...
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• Select Italic in the list box under Font style and click the Superscript checkbox under
Effects. Click OK. The axis title should now look more like 2n.
• Change the other axis title from n to n.
Formatting a Chart — Changes to the Plot Area
• Click somewhere in the Plot Area but not too close to the line on the plot or to a gridline or
to an axis. This selects the Plot Area. Several handles appear which you could use to
change the size and shape of the Plot Area.
• Double-click somewhere in the Plot Area to open the Format Plot Area dialogue box.
The Format Plot Area dialogue box is simple. Under the Border heading you can see that
the Custom option has been selected by default. This is a grey line. You haven’t seen it
because it is covered by the two axes and the topmost and rightmost gridlines:
• Select the None option under the Border heading.
• Ensure that the None option is selected under the Area heading too. There is no need for a
fancy background.
• Click OK. The chart now has a clean and uncluttered appearance.
Editing a Chart — Incorporating a new Data Series
The alterations which have been made so far are described as formatting actions in the Excel
documentation. They are to be contrasted with editing actions which include adding new
points to a data series or adding a new data series to a chart.
To add a second data series to the chart, a new series must be entered into the worksheet:
• Click cell C2 and thereby make C2 the active cell.
• Key in the formula =SQRT(B2) and click the Enter box to confirm.
• Check that C2 is still the active cell complete with its emphasised border indicating
selection. Notice the little black square at the bottom right-hand corner of the border.
This is the Fill handle.
• Point to the Fill handle and notice that the pointer changes to a +-sign.
• Drag the Fill handle downwards to cell C12 and release the mouse button. This is the
standard short-cut way of filling and is known as AutoFill.
Each cell in the C column takes on the square root of the value of its neighbour in the B
column. The default Format Category is General and the result is a mixture of whole
numbers and numbers taken to several decimal places. This looks messy:
• Check that the range C2:C12 is still selected, open Format and choose Cells...
• Select the Number tab and select Number as the Format Category. Check that the
number of Decimal places is shown as 2.
• Click OK. The values in the C column look much tidier.
• Make C1 the active cell and key 2(n/2) into the cell and click the Enter box to confirm.
• Make this entry look as much like 2(n/2) as you can (only the n is italic). Right-align the
entry and make it bold.
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One way to incorporate a new data series into a chart is known as drag and drop (however,
note that you cannot use this technique to add a new data series to a chart in
Excel 2007):
• Select the range C1:C12 (include the heading).
• Move the pointer to somewhere on the border of the selected range so that it takes the form
of a broad arrow (keep clear of the fill handle).
• Drag the border to somewhere in the chart (it doesn’t matter where) and release the mouse
button (this is the drop action). At the drop, a second data series appears on the chart.
The second data series is probably coloured and has markers. Some further formatting is
needed…
Formatting a Chart — Changing the Legend
• Check that the chart is selected. The Chart menu should be on the Menu bar.
• Open Chart and choose Chart Options... to open the Chart Options tab dialogue box.
• Select the Legend tab and click the Show Legend checkbox.
• Click OK. The legend, which was discarded at Step 3 of the Chart Wizard has now been
brought back. It provides a (somewhat unsatisfactory) key to distinguish the two data
series.
• Click anywhere inside the legend’s border to select the legend. Eight handles should
appear. By dragging the handles you can change the size and shape of the legend border.
By clicking inside the legend area away from a handle and then dragging, you can
reposition the legend…
• Stretch the border vertically and reposition the legend so that the two components are
roughly in line with the rightmost extremities of the two data series.
• Open Format and choose Selected Legend...
• Select the Patterns tab in the Format Legend tab dialogue box.
• Select the None option under the Border heading.
• Click OK. The legend’s border disappears but the handles remain to indicate that the legend
is still selected.
• Click outside the chart. This action is preparatory to the next illustration but it has the side
effect of deselecting the legend so the handles disappear.
Formatting a Chart — Changes to the new Data Series
The next step will be to format the new data series to make it a broken black line and to
remove its markers:
• Double-click somewhere on the line of the new plot between two markers to open the
Format Data Series tab dialogue box. Check that the Patterns tab is still selected.
• Change the Style of the line to a simple broken line and change the colour to black.
• Change the Marker option to None. Click OK.
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It is possible that the legend doesn’t quite fit into the space available and 2(n/2) (which is
erroneous anyway) is split over two lines. Whether or not this is the case, give the legend
more space…
• Click in the legend so that the eight handles appear. Drag the handle in the middle of the
left-hand side leftwards to make the legend wider. Crash into the chart itself, concluding
the drag halfway between the 9 and 10 gridlines.
• Click in the Plot Area of the chart to select it. Drag the handle in the middle of the righthand side to the left to make the chart less wide. The axis labels may turn (or may
already have turned) sideways. If this is the case…
• Double-click a label on the axis to open the Format Axis tab dialogue box.
• Select the Alignment tab and ensure that the Orientation is 0 Degrees.
• Click OK. Click outside the chart.
Naming Cells
The values in the C column are the square roots of the values in the B column. Suppose you
want these new values to be a factor of 4 larger.
You could simply adjust the formula in cell C2 to =4*SQRT(B2) and drag the fill handle
downwards to update the other cells in the C column.
If you then wish to experiment with other factors, the process of updating cell C2 and
dragging becomes slightly tedious. It is better to set aside some specific cell for the factor and
just change the contents of this one cell between experiments:
• Make D2 the active cell and key 4 into this cell. Click the Enter box to confirm. It seems
sensible to give a heading to this factor…
• Make D1 the active cell. Key in a (one character). Click the Enter box to confirm.
• Right-align this a and make it bold.
The obvious next steps are to adjust the formula in cell C2 to =$D$2*SQRT(B2) and then
drag downwards. Remember the use of dollar-signs to indicate an absolute address? The first
$ isn’t strictly needed but it does no harm.
To anyone used to ordinary mathematics, it would be much better if one could write the
formula simply as =a*SQRT(B2) and use a as the required reference to the value 4. There is
a facility for doing just that:
• Drag downwards from D1 to D2 so as to select the cell containing the name a and the cell
containing the value 4.
• Open Insert and choose Name ▸ Create... The Create Names dialogue box has the Top
row checkbox set. This indicates that the name a in the top row of the current selection
will be taken as a name which can be used in formulae. Click OK.
• Make C14 the active cell and try a simple experiment…
• Key in the formula =a+2 and click the Enter box to confirm. The value 6 is duly calculated
for the cell.
• Open Edit and choose Undo Typing to remove the 6.
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• Check that C14 is still the active cell. As usual C14 is noted in the Name Box (to the left
of the Formula Bar). To the right of the C14 in the Name Box there is a

button…

• Click the
and notice the single entry a in the drop-down list box. If you had created
several names, they would all be here too.
• Click this a and observe that cell D2 becomes the active cell (not cell D1 which has a in
it). Further, the Name Box doesn’t record this cell as D2 but as the name a.
• Make C2 the active cell. Modify the formula to =a*SQRT(B2) and click the Enter box to
confirm. The value in C2 changes from 1.00 to 4.00 and this change is reflected in the
chart.
• Drag the fill handle of C2 downwards to cell C12. The formulae in the other cells are duly
updated and the associated data series on the chart changes too.
• Experiment with different values in D2; try 10, 32, 100 and 0.1 and notice the changes
both to the values in the C column and to the chart.
• Check that you understand just why the second plot on the chart changes as it does as the
value of a is changed.
The heading in cell C1 needs editing. Start by double-clicking it:
• Double-click cell C1. This not only makes C1 the active cell but it also causes the flashing
insertion point to appear in the cell itself.
• Click in front of the 2 to ensure that the insertion point is to the left of the leading 2 in cell
C1 and key in a. (the dot separates the a from the 2 and implies multiplication).
• Click the Enter box to confirm. The change to the heading affects the legend in the chart
though this latter still isn’t right!
• Change the value in D2 to 1. You then get the values which you originally had for the
second data series.
You should by now be able to make most of the adjustments to a worksheet and to a chart
that you are likely to want to make. Unfortunately, there seems to be no way of changing 2n
into 2n and a.2(n/2) into a.2(n/2) in the legend. The best you can do is to change the headings
of columns B and C to something like 2ˆn and a.2ˆ(n/2).
Printing the Worksheet
Preview and print the worksheet:
• Ensure that the chart is not selected. Click a cell in the worksheet if it is.
• Open File and choose Print Preview. The appearance is not very satisfactory. As with
Flat.xls it would be better to move the chart below the tabulated values and move these
values to the right. Click Close and make the appropriate changes to the worksheet,
especially to the position of the chart.
• Use the Page Setup command to centre the entire worksheet horizontally and to add the
footer which incorporates your name and college. Preview again.
• When all is well, print the worksheet with the embedded chart.
• Clear the message window and collect the printed worksheet from the printer.
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• If the previewer is open, click Close. Then click Save and finally go File | Close to close
the workbook.
Powers of Two Concluded
This example has introduced a number of formatting and editing features. It also reflects real
life in the way that a chart is commonly built up in stages with a certain amount of backtracking and changing of mind on the way.
With the benefit of hindsight, the end product could have been set up more speedily. In
outline, the first step should have been to set up both the n and 2n columns and then, on entry
to the Chart Wizard, select XY (Scatter) as the Chart type rather than get into the mess that
resulted from using Line as the Chart type.
The requirement for a semi-log plot should have been ignored until a complete draft chart had
been completed. At that stage, the y-axis could have been selected and then formatted by
putting a tick in the Logarithmic scale checkbox in the Scale tab.
Leaving Excel
• Open File and choose Exit. A message window advises that you have made some changes
and asks whether you want to save these changes. Click Yes which saves the recent
changes and you then exit from Excel.
The workbook is now saved in the file Powers.xls and you leave Excel.
Logging off
• As at the end of every session, it is important to log off in the approved way:
start | Log Off
After a short wait, the screen returns to its idle state presenting the invitation to press:
Ctrl+Alt+Delete to Login

Summary
Here are some of the more important features which were referred to Session 6.
Workbook

A collection of worksheets and chart sheets in a single file.

Chart sheet

A sheet in a workbook occupied by a chart alone.

Series

A sequence of values in which there is some simple relationship between
one value and the next.

Data Series

A data series (on a chart) is a sequence of markers which might be joined
by a line.

Marker

A blob of some simple geometric shape on a chart indicating a point on a
data series.

Legend

A key indicating which markers apply to which data series on a chart.

Plot Area

The area of a chart where a graph (typically) is plotted.

Axis

A horizontal or vertical line on a graph, usually calibrated in such a way
that the coordinates of a point on the graph can be specified.
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Tick mark

Calibration line on an axis.

Gridline

Tick mark which runs right across a chart.

Chart Title

Text providing a caption to a chart.

Axis Title

Text providing a caption to an axis.

Axis label

Text associated with a tick mark or gridline.

Chart item

Generic term for the components of a chart.

Editing

Adding a new point to a data series or adding a new data series to a chart or
simply changing one or more points.

Formatting

Changing the appearance of a chart, usually by making changes to one or
more chart items.
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